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NOTE:  webTeacher( and the following training scripts (Module 1) are the property of TECH CORPS(.  While designed for use by K-12 teachers and students, the content may also be useful for other audiences.  Permission is granted to use these materials without charge, subject to the following restrictions: 

· Credit must be given to TECH CORPS as the original source;

· If the material is used in modified form, TECH CORPS must be cited as the original source, and it must be stated clearly that the material has been modified;

· The material may not be used as part of a commercial product, nor may it be sold for profit;

· You may freely print and copy these materials, subject to the preceding restrictions. 

· Any usage of this material not consistent with the preceding restrictions requires the explicit written permission of TECH CORPS. 

NOTE: NETSCAPE IS USED FOR EXAMPLES OF SENDING AND RECEIVING EMAIL. THE WEBSITE USES YAHOO. TRY TO USE NS FOR THE DEMO, SO THAT PEOPLE WILL GET MORE EXPOSURE TO DIFFERENT PROGRAMS. 

Training Module 2

Communicating

Before Getting Started

<talk>


1. Welcome everyone


Introduce yourself, and briefly describe your background.

2. Ask how many are returning students, and ask what brought new students to this class.


(e.g. personal interest, work related, etc.)

3. Ask the background or job title of those participating in today's class


(e.g. trainers, teachers, administrators...)

(Keep in mind the various types of participants, so that you can gear examples and discussions to their specific needs.) 

4. Discuss what the series has and will cover:


Module 1: 
Web Basics


Module 2:
Communicating

Module 3:
Multimedia


Module 4:
Homepage Construction


Module 5:
Peripherals and Utilities


Module 6:
The Web in Your Classroom

5. Discuss what today’s class training will cover:

The title of today's module is, "Communicating.” Today, we will examine one of the more intriguing aspects of the World Wide Web; namely, the way people communicate using the Internet. We will: 
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   learn how to send and receive Email, 
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   learn about Newsgroups, 
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   learn about Chat Groups, and finally
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   learn about Netiquette (i.e., commonly understood rules of Internet Etiquette).

6. Describe Expected Outcomes:


By the end of this class you will be able to:



Send and receive Email,



Subscribe and unsubscribe from Newsgroups,



Engage in on-line Chat Groups, and



Understand Internet Etiquette.

7. Review class times:


Mention - when the class will start


Mention - break-times, if any


Mention - when the class will end


Mention - that participants should ask questions whenever they need to, no matter 

    how simple they may feel it is.

Getting Started

<video>          Show Introduction to Module Two of webTeacher Video.

<optional>
(If the class has not seen the introduction to the webTeacher Video--featuring Senator John Glenn--then begin with the introduction, skip module one, and show module two.)
<talk> 
As the video points out, the Web offers vivid and exciting opportunities for teachers and students. One of the most exciting is the ability to communicate across great distances and at great speed! Of course, many of you already know that most of the websites we view originate in states (and even countries) outside our own. As passive viewers, we get to see these sites – depending upon the speed of our connections – very rapidly.


We can be more than passive viewers of the Internet; we can actually engage in on-line communications. One the easiest ways to do this is by using the Email feature of the Web. By emailing people, we can communicate our ideas; share lessons; contact students, parents, teachers, and/or administrators with valuable course information, and so forth. Let's see how this is done.

<section #1>
How to email using the Internet
<ask>
Who can tell us what Email is? [Answer: Email, or Electronic Mail, are messages sent between computers.]

How many of you in this class already use (or know how to use) email?

What do you use Email for?

 <NOTE>
If everyone is familiar with the use of e-mail, then you can skip this


section and go to section #2 (below).  Otherwise, continue with:
<demonstrate>For those of you who do not know how to use email, let me first show you what an email message looks like.

<note>
(It is assumed that you are using Netscape 4.5 or later on a Mac. Make necessary changes if you are using a different browser/e-mail program, or a different PC.  Point out to class that they can download--free of charge--the latest versions of Netscape or other browsers from the Web.)

<class>
Have class open browser and go to http://webteacher.org/windows.html. From splash screen go to “Communicating.”


In the left frame have class click on " Electronic Mail" under heading "EMail". 

<optional>
Have a volunteer read the following:

Electronic Mail 

One of the most important and fundamental uses of the Internet is that it allows electronic messages to be sent between computers that are connected to it. These messages are known as "Electronic Mail" or "email." 

There are many ways to set up an email account, but the basics of emailing remain the same. Choices include: 
· Setting up an account through your Internet Provider. In other words, whoever sets up your connection to the Internet provides email accounts as part of your access fee. In a university environment, a school's network services could provide an email program such as Pine for the students. 

· A full-featured email program such as Outlook, Outlook Express or Eudora. These off-the-shelf email programs sometimes come pre-loaded in your computer. These programs have many features and are set up to run with your Internet connection. 

· A Web-based free email service. Several Web "portal" sites, sites that want to be your gateway to the Internet (www.yahoo.com, www.hotmail.com), and provide free email. In exchange, you may have to endure a few advertisements, but these email services are easy to use and generally you can access them from home, the library or a friend's house: anywhere you can get on the internet.

Obviously, different email programs have a different look about them, but fortunately they all operate fundamentally the same way. For our discussion, we're going to look at the web-based free email service. They are accessible, functional and simple. 

<talk> 
Assuming that your web browser supports email--and that it has been properly configured--there are many ways to send an electronic message.  One of the easiest ways to send an electronic message, is to: 

<class>
Have class select "Messenger" from the pull-down menu under "Communicator." (This is for Netscape users. For IE users, select “New Message” under the “Mail” icon, OR from the main menu select Tools ( Mail and News ( New Message.)


<optional>
(Show how to select "New Message" by using the keyboard short cut.  Hold down the "command" key and the letter "m" on a Mac, or the “control” key and the letter “m” on a PC.)

<class>
Now let's compose an e-mail message. To make this interesting, let’s send an email to the President. Yes, the President has an email address! It is 

president@whitehouse.gov
Just in case the President doesn't have time to take care of your request, let’s enter the email address of any other person that you wish to receive copies of the message. In this case, let's send a copy to the Vice-President at:


vice-president@whitehouse.gov 
Have the class type their messages.

<talk>
Notice, if you want to attach a file to the mail message (for example, a file with some text, or even your picture) you can do so by clicking on the “Attach” button.
<demonstrate>When you're finished, you can send your message immediately by:

clicking the "Send" button (located on the "Message Toolbar"), or

selecting "Send Now" from "File" menu item, or

using the keyboard short cut of holding down the "command" key

 
and the "return" key.


Or, you may wish to send the message later by:



holding down the "Send" button (located on the "Message 



Toolbar") until the "Send Later" option becomes visible, or



selecting "Send Later" from "File" menu item, or



using the keyboard short cut of holding down the "shift" key, the 


"command" key, and the "return" key.

<optional>
If you want to mail messages from your home computer, you must be connected to the Web.  This means connecting to an Internet Service Provider (ISP).  Furthermore, you must make sure that the preferences are set according to the information provided by your ISP.  (You can see the preferences to set up e-mail by selecting "Preferences" from the "Edit" menu item.)

<note>
Assuming that your web browser supports email--and that it has been properly configured--you can receive messages just as easily as you send them.

<class>
From the left frame of webTeacher's “Communicating” page, have class click on "Receiving Electronic Mail."  

<select>
From the browser select "Messenger" from "Communicator" menu item.

<optional>
(You can use the keyboard short cut by holding down the "command" key and the numeral "2".)

<talk>
Make sure the "Message Toolbar" is opened.  If "Message Toolbar" is not visible; go to the "View" menu item, go to "Show" option, and select "Message Toolbar".  


Everyone should now have the "Messenger" window opened with the "Message Toolbar" visible.

<demonstrate>Once the Messenger window is opened, you can receive mail by clicking the “Get Msg” button appearing at the top left. (Alternatively, you can select “Get New Messages” from “File”menu option. Or, you can hold down the “Command” key and hit the letter “T”.)

<note>
Note that the appearance of my "Messenger" window may be different from yours.  If there is a difference, it is most likely due to the different ways in which we have set our preferences.  (Differences in appearance may also arise from different browsers, or different versions of browsers.)

<optional>
Have class go to "Edit" menu item, and select "Preferences".


From "Preference" list, go to "Mail & Newsgroups", and select "Window Settings".  (The "Window Settings" options appear in the right of the "Preference Window".)


From the options at the right, you can configure your window by choosing the layout you prefer for the main "Messenger" window.


Click "OK".  (This will close the "Preference Window".  Everyone should be viewing the "Messenger Window".)

<note>
If time permits, you may wish to review the following buttons and features.

<demonstrate>Drag the panes, in order to demonstrate how one can change the size of each pane.

<class>
Define the following headings on the "Message Toolbar":

<define>

Get Msg
- Get new mail & newsgroup messages

<define>

New Msg
- Create a new message

<define>

Reply

- Reply to sender of message

<define>

Reply All
- Reply to all in newsgroup

<define>

Forward
- Forward the selected message (i.e. the e-mail 



  
message that you are viewing)

<define>

File

- Save--as a file--the selected message (i.e. the 

e-mail message that you are viewing)

<define>

Next

- View next unread e-mail message

<define>

Print

- Print the selected message (i.e. the e-mail 




   
message that you are viewing)

<define>

Delete

- Delete the selected message (i.e. the e-mail 




message that you are viewing)

<define>

Stop

- Stop loading e-mail message

<select>
Open one of your e-mail messages, and point out:

<define>

Subject: 
- Title of the message (what was entered in subject 


   
   
field, at time message was composed)

<define>        

Date: 

- Date and time of message

<define>       

From: 

- E-mail address of person sending message

<define> 

Organization:   -  Organizational affiliation (if any) of person 



   
sending message

<define>         

To: 

- E-mail address of person to whom message was 



   
sent

<define>   

References: 
- Number, if this message is a response to a 

previous message

<talk>
You will find that using e-mail is very easy.  Many Email topics that we will not be able examine in this class are covered on webTeacher's site.

<talk>
Before we move to the next section, I want to show you how you can find the email address of people.

Most often you can ask your friends and acquaintances for their addresses. However, when this is not possible, or when you need to find email addresses in a systematic way, these links can help: 

· Institutional Directories: Internet 'Phonebook' and PH Directories, Listed by Institution 

· Finding People on the Net : Links and techniques for finding people's email addresses 

For more information about using these tools, see the later section on finding things on the Internet. 

<section 2> 
How to join newsgroups
<class>
Close all message windows, and make sure everyone is at the webTeacher site.  Have class click “Newsgroups" in left frame. 

<define>
Have a volunteer read:

Newgroups provide a mechanism whereby mail messages are systematically made available to large groups of people. In this case the mail message is said to be "posted" to the newsgroup. It is expected that a posted message will be replied to by other readers of the newsgroup, and those replies are usually also posted to the newsgroup. Therefore, subscribers can participate in discussions that may go on for very long periods and range over many topics related to the subject matter of the newsgroup. 

Newgroups are just email, but distributed to a broad audience. Newsgroups and their Frequently Asked Questions (FAQs) can be one of the richest sources of information on the Web.

<talk>
There are thousands of newsgroups.  Their interests range over many topics.

<demonstrate>Go to "http://www.liszt.com/news/"



type in "education" and hit return,



note that over 120 newsgroups appear,



scroll down -- point out K-12 groups

<optional>
Have class go to "http://www.liszt.com/news/"



Have class identify newsgroups with educational topics.

<class>
Have everyone return to webTeacher's site. Have class click "Newsgroups" under “Communicating” in left frame, and follow. 

<talk>
In order to read messages posted to a newsgroup, one must have a "Newsreader".

<define>
Newsreaders allows one to read and post newsgroup items, and to manage these items in some systematic way.  There are various newsreader programs available including those within most popular web browsers.

<talk>
From the "Communicator" menu item, select "Newsgroups".

<optional>
(You can also use the keyboard shortcut by holding down the "command" key, the "option" key, and the number "3".)

<note>
You will notice many similarities with the Netscape Mail interface, and the main Netscape browser window that we have encountered before; this is one of the advantages of using an integrated browser package supporting additional functions like mail and newsreading. 

                       
(Remember, that you can change the way the browser looks by changing the preferences.) 

   
The Newsgroup Window may be divided into 4 basic parts:

(point out these parts, as you mention them)

1. the control buttons, in one panel,

2. a list of newsgroups, in the next panel,

3. a list of posted items, (assuming a particular newsgroup has been selected), and

4. the text of a message, (assuming a message has been selected from the list of posted items). 

<demonstrate>Open a newsgroup on your computer and open a message.

<talk>
You can see how easy it is to use a newsreader to browse messages posted to newsgroups.  But, how can we add or remove newsgroups from the list displayed in the browser? 

   
The first step in adding newsgroups to the list is to display all available newsgroups.  

<class>
From the "Communicator" menu item, select "Newsgroups".


(You can also use the keyboard shortcut by holding down the "command" key, the "option" key, and the number "3".)


Then, from the "File" menu item, select "Subscribe".  (This will open the "Subscribe to Folders and Newsgroups" window.)  This may take a moment or two to open, so be patient.

<demonstrate> Scroll down to K12 and open folders within.  (For example, open up the "K12.ed" folder to display all of the newsgroups.)


Once the newsgroups are visible, click on a button to subscribe to the newsgroup.  (A check mark indicates that you are already subscribed to the newsgroup. If you have just checked a newsgroup, then you will have to wait until you've closed the "Subscribe to Folders and Newsgroups" window before you will be subscribed to that group.)


Note, that if you want to un-subscribe from a newsgroup; merely click the button so the check mark disappears.  (The button, in other words, toggles between no check mark, and check mark.)

<class>
Have class subscribe to newsgroups

<optional>
I want to discuss briefly netiquette in newsgroups. 

<define>
Netiquette is etiquette on the net, i.e. Web.


A modicum of etiquette is required to allow newgroups to function efficiently, without sinking into unrestrained name-calling.


Perhaps the most important rule of using newsgroups is to "look before you leap".  It is advisable to monitor a newsgroup for a while before you begin to post to it, to see what kinds of materials appear there, to see how tolerant the newsgroup is of divergent opinion, and to learn where the FAQ is for the newsgroup. 

   
FAQ stands for "Frequently Asked Questions."  Most newsgroups post their most frequently asked questions, along with answers, in an FAQ file accessible somewhere on the Web--usually at an FTP or HTTP site.  


If you are new to newsgroups, then it is important to point out that many users of newsgroups are highly intolerant of users who ask questions or post information that suggest they have not read the FAQs. 

  
Sometimes such action can bring swift retribution from a member--or members--of a newsgroup.  For example, if you post an ad for your old Macintosh SE in the newsgroup "comp.infosystems.www.authoring.html" (which is devoted to authoring html documents and frequented by some rather nice people and also by some highly intolerant and opinionated people), you should just lay low for a few days because you will be bashed mightily--and rightfully so, in this case--by e-mail and postings from irate members of the newsgroup.  Such e-mail attacks are called "Flaming", and are a common punishment for those who violate newsgroup etiquette. 

   
Another reprehensible act to denizens of newsgroups is the practice of blanket-posting something to every newsgroup around, whether appropriate or not.  For example, the posting to all Usenet newsgroups of an advertisement promoting a commercial product or service falls into this category.  Such postings are called "Spamming", and those judged guilty of spamming the net may be flamed so badly that their computer systems become unusable for a period, because of the volume of e-mail sent in protest. 

   
To avoid troubles, remember: DO NOT POST TO GROUPS THAT ARE NOT INTERESTED IN YOUR MESSAGE, post only to those groups clearly related to the subject matter of your message, and do not post advertisements of any kind unless that’s specifically allowed or encouraged (ie, the purpose of the group). 

<optional>
[If your class is composed of teachers, you may want to include the following remarks.]  Finally, there is the issue of Classroom Liability.
Teachers using the Internet in class should be aware of potential problems. Before allowing their students access to the Web, it is advisable for teachers (and even school administrators) to obtain consent forms from parents emphasizing that while all efforts will made to see that children access only appropriate material, common sense dictates that no monitoring system is foolproof and, in the final analysis, students must assume some responsibility for accessing only appropriate material.

<section 3>
How to conduct on-line research

In the first module, we discussed how to use search engines.  I want to revisit that topic, and add to it.  In particular, I want to talk about a few ways by which you can narrow your searches when conducting research on-line.


In some search engines, using special terms, a search can be limited: 

<class>
Type in http://www.altavista.com, and go to the Alta Vista search engine.


You should all be at Alta Vista's home page.  This page is used for general searches.  However, if you want to conduct more precise searches you need to click on the "Advance" button (next to the “Search” button).

<note> 
(According to Alta Vista, "The main difference between the two is the ability of Advanced Search to use Boolean expressions.  Boolean expressions are the words OR, AND, AND NOT, and NEAR, used to create relationships among the keywords in your search query. Using these expressions allows you to tailor your search to find exactly what you are looking for.")

<class>
Here is a sample of Advanced Search that uses all of the advanced features: 


1. Type "(ballroom OR salsa) AND dance" in the Boolean query box.  This Boolean query will find all documents containing the phrases "ballroom dance" and "salsa dance".  


2. Type "tango waltz" in the "Sort by:" box.  This step sorts the documents so that tango and waltz appear at the top of your results.  


3. Type "01/JAN/99" in the "From:" box and "30/JUN/99" in the "To: box".  This step limits the results to documents that have been updated in the first half of 1999.  Note:  if you do not include a month or year in the "From:" or "To:" fields, the search will use the current month and year.


4. Click the "Search" button to begin your search. 

<note>
Note also that with most search engines, CASE RULES; i.e. searches are case sensitive.  When searching for topics, use lower case to get more results--or "hits"--and use upper case to return fewer results. 

<section 4>
Going further: Usenet newsgroups

<talk>
Both e-mail and newsgroups are valuable tools for collaborating. These collaborations can be among friends and colleagues from within the same school; or they can be among people from around the world.  It's amazing to think that through the Web not only can you read about recent events--like the tensions between India and Pakistan--but you can e-mail people and get their first hand accounts of the events.  

<demontrate> Have class go to webTeacher’s site: http://www.webteacher.org/windows.html

click on “Communicating”, from left navigation panel; click on “Going Further” under “Newsgroups”


Ask the class to click on a few of the following sites.  General information about Usenet newsgroups may be found in the following links. 

· Usenet Info Center 

· Newsgroups for K-12 

· Master List of Newsgroup Hierarchies 

Newsgroup issues specific to the K-12 environment are addressed at: 

· Internet Newsgroups 

· K-12 Internet and Web Issues
<talk>
There are some other ways of collaborating on the Web that I want to mention. 


For a number of years, a staple for rapid and broad distribution of information on the Web has been the use of Automatic Mail Lists (sometimes called list-servs).  Although many of the functions of these lists are being supplanted by web sites and by newsgroups, mail lists still play a large role in distributing information and facilitating collaboration.  

<define> 
Automated mail lists are basically e-mail with the potential for large impact because they are distributed to a large group (thus, they are closely related to newsgroups). 

<class>
Have class open webTeacher's site, and go to "Going Further" under heading "#13 Mail Lists".  Here are some web resources to help you get started in subscribing to mail lists. 

<select>
Go to one of these sites with class.



Mailing Lists for Teachers 




(http://teachers.net/mailrings/)

         

Listservs for K-12 and Children 




(http://falcon.jmu.edu/~ramseyil/listserv.htm )

         

Email Discussion Groups/Lists Resources 




(http://www.pbs.org/uti/guide/email.html )

         

More Email Discussion Groups 

(http://www.webliminal.com/Lrn-web04.html, nb: dated, since it refers to NS 4; but has some good info and links.)

<demonstrate>You can find additional sites using search engines.  For example, try this search, which uses the Alta Vista search engine with the search string: 

                         
+listserv+"mail list"+"k-12"

<class>
Have class conduct searches using their own verbiage.  


Discuss which strategies were most successful.

<talk>
Another tool for collaboration is called "chat groups".  Chat groups allow users connected by the Web to converse with each other by typing messages that appear on everyone's screens.


A popular means to chat is through Internet Relay Chat, or just "IRC" to those who use it frequently.  On IRC, several persons can simultaneously participate in a discussion over a particular "channel", or even multiple channels.  There is no restriction to the number of people in a given discussion nor to the number of channels that can be formed.  There are IRC users in many countries, and it can serve as an inexpensive substitute for long distance telephone conversations. 

<point out>
Teachers should note that IRC chat groups are often free-wheeling, and can easily stray into topics that may not be appropriate for children.  The rules of Internet Safety are probably more critical for chat groups than for any other area of Web use.  (In addition to this concern, some chat groups are oriented more toward recreation and "killing time" than toward material of educational value.)


If you are interested in learning more about chat groups from webTeacher's site, bookmark "Going Further" under “Chat Groups".

<talk>
The last type of collaboration on the Web that I will describe today is called teleconferencing.  


Teleconferencing has many definitions.  I think of it as using various technologies to bring people together over space and time.  No doubt the first modern use of teleconferencing was when Alexander Graham Bell said to Thomas A. Watson, "Mr. Watson--come here--I want to see you."


There are three different types of teleconferencing:

<define>
Audio Teleconferencing - uses the telephone as the interactive medium

<define>
Video Teleconferencing - uses video, computing, and communication technologies.  Video teleconferencing can be "Point-to-Point", or it can be "Broadcast".  "Point-to-Point" video conferencing means having both parties--or sites--view one another interactively, like face to face meetings.  "Broadcast" video conferencing means having one party--or site--broadcast its image to many dedicated down-link sites.

<define>
Audio Graphics Teleconferencing - uses communications and computing technologies.  AGT allows one to move text, photographs, computer generated images, and large files over ordinary telephone lines (as the Internet provides).  Since video is not transmitted, wider bandwidths--associated with video teleconferencing--are not necessary.

<note>
The webTeacher site examines one such video teleconferencing tool called, CU-SeeMe, in greater detail.  (click on "Video Teleconferencing" under heading "Video".)

<talk>
SESSION WRAP-UP:  Leave time to answer questions.   If someone has a very specific question that is not of general relevance, tell him or her that you'll answer that "off-line" (one-to-one) after the session is over.


If disks have been provided, they can download the list of bookmarks they visited today.  No disk?  No Problem!  Most of the sites they visited today can be easily retraced through webTeacher!

<optional>  
Ask people what they think they have learned today.  Review material.

<optional>  
Leave some time (15 minutes, if possible) for people who want to stay and use the computer on-line. 
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